Abstract

These Application Notes describe a sample configuration using Session Initiation Protocol (SIP) trunking between the Verizon Business IP Trunk SIP Trunk Service Offer and an Avaya IP Office solution. In the sample configuration, the Avaya IP Office solution consists of an Avaya IP Office 500 Release 7.0 Preferred Edition, Avaya Voicemail Pro, Avaya IP Office Softphone, and Avaya SIP, H.323, digital, and analog endpoints.

These Application Notes complement previously published Application Notes by illustrating the configuration screens and Avaya testing of IP Office Release 7.0. Capabilities first introduced in IP Office Release 6.1 are also illustrated, including transfer using SIP REFER to Verizon, use of DNS SRV to determine the Verizon Business SIP signaling information from a Verizon DNS Server, and the support of Avaya 1100-Series and 1200-Series IP Deskphones (SIP) registered to IP Office.

IP Office Release 7.0 has not been independently certified by Verizon labs. These Application Notes can be used to facilitate customer engagements via the Verizon field trial process, pending Verizon labs independent certification.

The Verizon Business IP Trunk service offer referenced within these Application Notes is designed for business customers. The service enables local and long distance PSTN calling via standards-based SIP trunks directly, without the need for additional TDM enterprise gateways or TDM cards and the associated maintenance costs.

Information in these Application Notes has been obtained through DevConnect compliance testing and additional technical discussions. Testing was conducted in the Avaya Solution & Interoperability Test Lab, utilizing a Verizon Business Private IP (PIP) circuit connection to the production Verizon Business IP Trunking service.
# Table of Contents

Table of Contents .......................................................................................................................... 2
1. Introduction ........................................................................................................................................ 4
2. General Test Approach and Test Results ......................................................................................... 5
   2.1. Interoperability Compliance Testing ......................................................................................... 5
   2.2. Test Results ................................................................................................................................ 6
2.3. Support ........................................................................................................................................... 8
   2.3.1. Avaya ........................................................................................................................................ 8
   2.3.2. Verizon ................................................................................................................................. 8
3. Reference Configuration ....................................................................................................................... 9
4. Equipment and Software Validated .................................................................................................. 11
5. Configure Avaya IP Office .................................................................................................................. 11
   5.1. Physical, Network, and Security Configuration ......................................................................... 12
   5.2. Licensing .................................................................................................................................... 14
   5.3. System Settings ............................................................................................................................ 16
      5.3.1. System Tab .......................................................................................................................... 16
      5.3.2. LAN Settings ....................................................................................................................... 17
      5.3.3. Voicemail ............................................................................................................................ 22
      5.3.4. System Telephony Configuration ....................................................................................... 22
      5.3.5. System Twinning Configuration ......................................................................................... 23
   5.4. SIP Line ....................................................................................................................................... 23
      5.4.1. SIP Line - SIP Line Tab ....................................................................................................... 24
      5.4.2. SIP Line - Transport Tab .................................................................................................... 26
      5.4.3. SIP Line - SIP URI Tab ........................................................................................................ 27
      5.4.4. SIP Line - VoIP Tab ............................................................................................................. 28
   5.5. Users, Extensions, and Hunt Groups ............................................................................................ 29
      5.5.1. User 201 ............................................................................................................................ 29
      5.5.2. User 30026 ........................................................................................................................ 32
      5.5.3. User 235 (Avaya 1140E) .................................................................................................... 36
      5.5.4. User 238 (Avaya 1220) ....................................................................................................... 39
      5.5.5. Hunt Groups ....................................................................................................................... 44
   5.6. Short Codes .................................................................................................................................. 46
   5.7. Incoming Call Routes .................................................................................................................... 48
   5.8. ARS and Alternate Routing ......................................................................................................... 52
   5.9. Privacy / Anonymous Calls ....................................................................................................... 55
   5.10. SIP Options Frequency ............................................................................................................. 55
   5.11. Saving Configuration Changes to IP Office .............................................................................. 56
7. Configure Avaya 1140E and Avaya 1220 Telephone ......................................................................... 58
8. Verification Steps ............................................................................................................................... 60
   8.1. System Status Application ......................................................................................................... 60
   8.2. System Monitor Application ..................................................................................................... 63
   8.3. REFER Testing ............................................................................................................................ 66
      8.3.1. Wireshark Trace Illustration for REFER-Transfer ............................................................. 67
8.4. DNS SRV Testing...................................................................................................................... 70
  8.4.1. Wireshark Trace Illustration for DNS SRV .................................................................... 70
9. Conclusion ............................................................................................................................... 73
10. Additional References ........................................................................................................... 73
  10.1. Verizon Business .............................................................................................................. 74
11. Appendix – Example SIP Trunk Template............................................................................. 74
1. Introduction

These Application Notes describe a sample configuration using Session Initiation Protocol (SIP) trunking between the Verizon Business IP Trunk SIP Trunk Service Offer and an Avaya IP Office solution. In the sample configuration, the Avaya IP Office solution consists of an Avaya IP Office 500 Release 7.0 Preferred Edition, Avaya Voicemail Pro, Avaya IP Office Softphone, and Avaya SIP, H.323, digital, and analog endpoints.

These Application Notes complement previously published Application Notes [JRR-IPOR6] by illustrating the configuration screens and Avaya testing of IP Office Release 7.0. Capabilities first introduced in IP Office Release 6.1 are also illustrated, including transfer using SIP REFER to Verizon, use of DNS SRV to determine the Verizon Business SIP signaling information from a Verizon DNS Server, and the support of Avaya 1100-Series and 1200-Series IP Deskphones (SIP) registered to IP Office.

REFER-based transfer can allow the trunks to the IP Office location to be released when a call is transferred, resulting in a connection that no longer uses IP Office resources. The use of DNS SRV obviates the need to statically configure the Verizon SIP Signaling IP Address and port information in IP Office, thus allowing dynamic, automatic updates to SIP signaling to occur without manual intervention by the IP Office administrator, if Verizon network conditions change.

**IP Office Release 7.0 has not been independently certified by Verizon labs. These Application Notes can be used to facilitate customer engagements via the Verizon field trial process, pending Verizon labs independent certification.**

Customers using Avaya IP Office with the Verizon Business IP Trunk SIP Trunk service are able to place and receive PSTN calls via the SIP protocol. The converged network solution is an alternative to traditional PSTN trunks such as ISDN-PRI.

Verizon Business IP Trunk service offer can be delivered to the customer premise via either a Private IP (PIP) or Internet Dedicated Access (IDA) IP network terminations. Although the configuration documented in these Application Notes used Verizon’s IP Trunk service terminated via a PIP network connection, the solution validated in this document also applies to IP Trunk services delivered via IDA service terminations.

2. General Test Approach and Test Results

The Avaya IP Office location was connected to the Verizon Business IP Trunk Service, as depicted in Figure 1. Avaya IP Office was configured to use the commercially available SIP Trunking solution provided by the Verizon Business IP Trunk SIP Trunk Service. This allowed Avaya IP Office users to make calls to the PSTN and receive calls from the PSTN via the Verizon Business IP Trunk SIP Trunk Service.

2.1. Interoperability Compliance Testing

The testing included executing the test cases detailed in Reference [VZ-Test-Plan], which contains the Verizon Test Suite for VoIP Interoperability for IP Trunking. In the summary below, the relevant test case numbers from [VZ-Test-Plan] are shown parenthetically. The testing included the following successful SIP trunk interoperability compliance testing:

- DNS SRV (TC2) to determine the Verizon IP Trunk SIP signaling information, using UDP for SIP signaling (TC46) and full SIP headers (TC49).
- Incoming calls (TC3, TC13) from the PSTN were routed to the DID numbers assigned by Verizon Business to the Avaya IP Office location. These incoming PSTN calls arrived via the SIP Line and were answered by Avaya SIP telephones, Avaya H.323 telephones, Avaya digital telephones, analog telephones, Avaya IP Office Softphone, and Avaya IP Office Voicemail Pro voicemail and auto-attendant applications. The display of caller ID (TC8) on display-equipped Avaya IP Office telephones was verified. IP Office sends 180 Ringing (without SDP) for calls ringing to an IP Office user (TC50).
- Incoming calls answered by members of Hunt Groups were verified.
- Outgoing calls (TC17, TC18, and TC20) from the Avaya IP Office location to the PSTN were routed via the SIP Line to Verizon Business. These outgoing PSTN calls were originated from Avaya SIP telephones, Avaya H.323 telephones, Avaya digital telephones, analog endpoints, and Avaya IP Office Softphone. The display of caller ID (TC36) on display-equipped PSTN telephones was verified. Outbound calls subject to “fast answer” (Verizon 200 OK without a preceding 18x, TC37) were tested successfully.
- Proper disconnect when the caller abandoned a call before answer for both inbound (TC6) and outbound (TC19) calls.
- Proper disconnect when the IP Office party (TC5, TC17) or the PSTN party (TC4, TC18) terminated an active call.
- Proper busy tone heard when an IP Office user called a busy PSTN user (TC43), or a PSTN user (TC7, TC12) called a busy IP Office user (i.e., if no redirection was configured for user busy conditions)
- Various outbound PSTN call types were tested including long distance (TC20), international (TC21), toll-free (TC29), operator assisted (TC30-TC34), directory assistance (TC23-TC25), and other non-emergency x11 (TC22, TC26, TC28) calls.
- Requests for privacy (i.e., caller anonymity) for IP Office outbound calls (TC38) to the PSTN were verified. That is, when privacy is requested by IP Office, outbound PSTN calls were successfully completed while withholding the caller ID from the displays of display-equipped PSTN telephones.
Privacy requests for inbound calls from the PSTN to IP Office users were verified. That is, when privacy is requested by a PSTN caller (TC11), the inbound PSTN call was successfully completed to an IP Office user while presenting an “anonymous” or “withheld” display to the IP Office user.

SIP OPTIONS monitoring (TC93) of the health of the SIP trunk was verified. Both Verizon Business and IP Office were able to monitor health using SIP OPTIONS. The Avaya IP Office configurable control of SIP OPTIONS timing was exercised successfully.

IP Office outbound calls were placed with simple short codes as well as using ARS.

Incoming and outgoing voice calls using the G.729(a) (TC60) and G.711 ULAW (TC59) codecs, and proper protocol procedures related to media (TC47, TC48, TC55, TC61).

DTMF transmission (RFC 2833) with successful voice mail navigation using G.729a and G.711MU for incoming (TC54) and outgoing (TC53) calls. Successful navigation of a simple auto-attendant application configured on IP Office Voicemail Pro.

The “callback” feature of Avaya Voicemail Pro was tested successfully. When a message was left for a voice mail subscriber with “callback” configured, an outbound call was placed to the subscriber’s configured mobile telephone via the SIP Line to Verizon Business. Upon answer, Voicemail Pro announced the call and prompted the user to enter the “#” key to accept the call. The user had the opportunity to navigate the voicemail TUI via DTMF (e.g., to listen to the voice message that stimulated the callback).

Inbound (TC14) and outbound (TC42) long holding time call stability.

Telephony features such as call waiting (TC9), hold (TC56), transfer using re-INVITE (TC65-TC76), transfer using REFER (i.e., REFER with Replaces per TC77-TC84), and conference (TC89-TC92). IP Office users may use blind transfer, but IP Office will not send a blind REFER to Verizon (i.e., TC85-TC88).

Inbound calls from Verizon IP Trunk Service that were call forwarded (TC52) back to PSTN destinations via Verizon IP Trunk Service, presenting true calling party information to the destination PSTN telephone.

Mobile twinning (TC52) to a mobile phone, presenting true calling party information to the mobile phone. Outbound mobile call control was also verified successfully (e.g., using DTMF on a twinned call to place new calls and create a conference via a mobile phone).

Proper DiffServ markings for IP Office SIP signaling (TC64) and RTP (TC63) media.

Inbound fax (TC10) and outbound fax (TC35) calls. See the following section for fax considerations.

Inbound (TC98) and outbound G.729a voice calls (TC97) for which intentionally induced ambient fax tone “noise” played to the voice call causes Verizon to issue a re-INVITE to G.711.

2.2. Test Results

Interoperability testing of the sample configuration was completed with successful results. The following observations were noted:
1. **Fax Considerations**: At time of writing, the Verizon IP Trunk service does not support T.38 fax, and T.38 fax was not available on the production Verizon circuit used in the verification of these Application Notes. However, Verizon may introduce support for T.38 fax in the future, and therefore the following considerations may be instructive, should T.38 fax become available from Verizon IP Trunk service after the publication of this document.

Until T.38 fax is available from Verizon, if fax calls will use the SIP Line to Verizon, the fax may use a fax transport method of “none”, or a fax transport method of “G.711”. See Section 5.4.4. With “none” selected, IP Office Release 7.0, like IP Office Release 6.0, may complete the fax successfully using the G.711MU codec, but will not make special fax-aware provisions for the call, and fax failure rates may be unacceptable. In IP Office Release 6.0, a separate analog POTS line was recommended for fax for this reason. The new IP Office Release 7.0 fax transport method of “G.711” is intended to improve fax success rates by making fax-aware provisions for calls known to be fax calls, such as disabling the digital signal processing appropriate for voice calls.

Once T.38 fax is available from Verizon, the SIP Line on IP Office may be configured for T.38. However, note that a SIP Line on IP Office Release 7.0 configured to support T.38 fax will not “fallback” to fax over G.711, should the Verizon network reject the IP Office attempt to transition to T.38 by sending a 488 Not Acceptable message. This is true even if the fax machine is connected to a SIP ATA registered to IP Office rather than a native IP Office analog port. The IP Office product team is evaluating CQ 41553 documenting this issue. The Verizon network may reject a request to transition to T.38 because T.38 support may not be uniformly available in the Verizon network for some time. If T.38 is turned on in the Verizon network, but is not enabled on the IP Office SIP Line, Verizon may send a re-INVITE to IP Office in an attempt to transition to T.38. The fax call may fail because Verizon is expecting IP Office to reply with a 488 Unacceptable Here to the Verizon T.38 re-INVITE, leaving the call in a fax over G.711 condition, which does not occur. The IP Office product team is evaluating CQ 41552 documenting this issue.

2. When a call is put on hold by an IP Office user, there is no indication sent via SIP messaging to Verizon. This is transparent to the users on the call.

3. When using the IP Office Softphone, inbound PSTN calls from the Verizon Business IP Trunk service to the IP Office Softphone may negotiate to the G.711MU codec, even if the SIP Line configuration lists G.729a first on the VoIP tab (as shown in Section 5.4). Specifically, if the IP Office Softphone user has logged in with the “IP Office: Default” profile, and the Automatic Codec Preference parameter on the System  Telephony tab is set to “G.711 ULAW 64K”, an inbound call from the Verizon Business IP Trunk service to the IP Office Softphone will use G.711MU. The IP Office Softphone user can log in with the “IP Office: Low Bandwidth” profile to ensure use of G.729a for both inbound and outbound calls via the SIP Line to Verizon Business.
4. As expected, when a call arriving from the Verizon IP Trunk service is forwarded or twinned out to the PSTN via the Verizon IP Trunk service, IP Office populates the Diversion header with the SIP information of the IP Office party that has forwarding or twinning activated. Verizon admits the call based on a valid Verizon DID in the Diversion header. The From header retains the true identity of the calling PSTN party, and the P-Asserted-Identity is not sent, since it is recommended that the PAI parameter on the SIP Line URI tab be set to “None” as shown in Section 5.4.3. This allows the forwarding or twinning destination to see the true caller id. However, when a call from a local IP Office user is call forwarded to the PSTN via the Verizon IP Trunk Service, the Diversion header is populated with the local calling party’s information, rather than the information associated with the forwarding user. If the local IP Office calling party has a valid Verizon DID, this anomaly will not cause any user-perceivable problem. However, if the local IP Office calling party does not have a valid Verizon DID, the forwarded call will not be routed by Verizon, since none of the origination headers will include a valid Verizon DID. This anomaly is under investigation by the IP Office product team as CQ41165.

5. When the IP Office transferor of an outbound call to the PSTN via Verizon is a SIP device registered to IP Office (e.g., Avaya 1140E, Avaya 1220, or IP Softphone in the sample configuration), and the REFER transfer option is enabled on the SIP Line to Verizon, the transferor may briefly see the display “Transfer failed” after the final user operation, even if the transfer has actually succeeded. On the production circuit used for testing, Verizon did not send NOTIFY messages to IP Office to signal transfer completion. This anomaly is under investigation by Verizon and the IP Office product team as CQ MRDB00116583.

2.3. Support

2.3.1. Avaya
For technical support on the Avaya products described in these Application Notes visit http://support.avaya.com.

2.3.2. Verizon
For technical support on Verizon Business IP Trunk service offer, visit the online support site at http://www.verizonbusiness.com/us/customer/.
3. Reference Configuration

Figure 1 illustrates an example Avaya IP Office solution connected to the Verizon Business IP Trunk SIP Trunk service. The Avaya equipment is located on a private IP subnet. An enterprise edge router provides access to the Verizon Business IP Trunk service network via a Verizon Business T1 circuit. This circuit is provisioned for the Verizon Business Private IP (PIP) service. The optional Verizon “unscreened ANI” feature is not needed by IP Office, and “unscreened ANI” is not provisioned on the production circuit used for testing. See Section 5.4.3.

In the sample configuration, IP Office receives traffic from the Verizon Business IP Trunk service on port 5060. IP Office uses DNS SRV, using UDP for transport, to determine the IP Address and port to be used to send SIP signaling to Verizon. In the sample configuration, the DNS process will result in SIP signaling being sent to IP Address 172.30.209.21 and port 5071, but these values are not statically configured in IP Office. As shown in Table 1, the Verizon Business IP Trunk service provided Direct Inward Dial (DID) numbers. These DID numbers were mapped to IP Office destinations via Incoming Call Routes in the IP Office configuration. Verizon Business used FQDN pcelban0001.avayalincroft.globalipcom.com. The Avaya IP Office environment FQDN known to Verizon was adevc.avaya.globalipcom.com.
Table 1 shows the mapping of Verizon-provided DID numbers to IP Office users, groups, or functions. The associated IP Office configuration is shown in Section 5.

<table>
<thead>
<tr>
<th>Verizon Provided DID</th>
<th>Avaya IP Office Destination</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>732-945-0228</td>
<td>Auto-Attendant on Voicemail Pro</td>
<td>See Section 5.6</td>
</tr>
<tr>
<td>732-945-0229</td>
<td>x30026</td>
<td>Avaya 1616 Telephone, or Avaya IP Office Softphone configured as x30026</td>
</tr>
<tr>
<td>732-945-0231</td>
<td>x201</td>
<td>Digital Telephone with Mobile Twinning Active</td>
</tr>
<tr>
<td>732-945-0232</td>
<td>x203</td>
<td>Digital Telephone</td>
</tr>
<tr>
<td>732-945-0233</td>
<td>x209</td>
<td>Analog telephone or Fax machine, see Section 2.2</td>
</tr>
<tr>
<td>732-945-0285</td>
<td>x235</td>
<td>Avaya 1140E Telephone (SIP)</td>
</tr>
<tr>
<td>732-945-0286</td>
<td>x238</td>
<td>Avaya 1220 Telephone (SIP)</td>
</tr>
<tr>
<td>732-945-0234</td>
<td>Voicemail Collect on Voicemail Pro</td>
<td>See Section 5.6, also used for Voicemail Pro Callback</td>
</tr>
<tr>
<td>732-945-0235</td>
<td>x30025</td>
<td>Avaya 1616 IP Telephone</td>
</tr>
<tr>
<td>732-945-0236</td>
<td>“200 Main” Hunt Group</td>
<td>Collective Ring Hunt Group</td>
</tr>
<tr>
<td>732-945-0237</td>
<td>30200 Hunt Group</td>
<td>Sequential Ring Hunt Group</td>
</tr>
</tbody>
</table>

Table 1: Verizon DID to IP Office Mappings
4. Equipment and Software Validated

Table 2 shows the equipment and software used in the sample configuration.

<table>
<thead>
<tr>
<th>Equipment</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avaya IP Office 500</td>
<td>Release 7.0 (5)</td>
</tr>
<tr>
<td>Avaya IP Office Manager</td>
<td>Release 9.0 (5)</td>
</tr>
<tr>
<td>Avaya IP Office Voicemail Pro</td>
<td>Release 7.0 (17)</td>
</tr>
<tr>
<td>Avaya IP Office Voicemail Pro Client</td>
<td>Version 7.0 (17)</td>
</tr>
<tr>
<td>Avaya 1600-Series Telephones (H.323)</td>
<td>Release 1.3</td>
</tr>
<tr>
<td>Avaya 1140E IP Deskphone (SIP)</td>
<td>SIP1140e.04.01.13.00</td>
</tr>
<tr>
<td>Avaya 1220 IP Deskphone (SIP)</td>
<td>SIP12x0.04.01.13.00</td>
</tr>
<tr>
<td>Avaya 2400-Series and 5400-Series Digital Telephones</td>
<td>REL: 6.00 (downloaded from IP Office)</td>
</tr>
<tr>
<td>Avaya IP Office Softphone</td>
<td>Release 3.1.2.17 59616</td>
</tr>
<tr>
<td>Brother Intellifax 1360 (analog fax)</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Table 2: Equipment and Software Tested

5. Configure Avaya IP Office

IP Office is configured via the IP Office Manager program. For more information on IP Office Manager, consult reference [IPO-MGR]. From the IP Office Manager PC, select Start → Programs → IP Office → Manager to launch the Manager application. A screen that includes the following in the center may be displayed:

**WELCOME to IP Office Administration**

**What would you like to do ?**

- Create an Offline Configuration
- Open Configuration from System
- Read a Configuration from File

Open the IP Office configuration, either by reading the configuration from the IP Office server, or from file. The appearance of the IP Office Manager can be customized using the View menu. In the screens presented in this section, the View menu was configured to show the Navigation pane on the left side, the Group pane in the center, and the Details pane on the right side.
5.1. Physical, Network, and Security Configuration

This section describes attributes of the sample configuration, but is not meant to be prescriptive. Consult reference [IPO-INSTALL] for more information on the topics in this section.

In the sample configuration, looking at the IP Office 500 from left to right, the first module is blank (i.e., no module is physically inserted). The next slots from left to right contain a VCM64, a Digital station module, and a “Phone8” analog module. The VCM64 is a Voice Compression Module supporting VoIP codecs. The Digital module allows connection of Avaya 5400-Series and Avaya 2400-Series Digital telephones. Referring to Figure 1, the Avaya 5410 telephone with extension 201 is connected to port 1 of the Digital module, and the Avaya 2410 telephone with extension 203 is connected to port 3 of the Digital module. The “Phone8” module allows connection of analog devices such as simple analog telephones or fax machines. In the testing of the sample configuration, an analog telephone or a fax machine is connected to port 1 of the “Phone8” module.

The following screen shows the modules in the IP Office used in the sample configuration. To access such a screen, select Control Unit in the Navigation pane. The modules appear in the Group pane. In the screen below, IP 500 is selected in the Group pane, revealing additional information about the IP 500 in the Details pane.

In the sample configuration, the IP Office LAN1 port is physically connected to the local area network switch at the IP Office customer site. The default gateway for this network is 1.1.1.1. To add an IP Route in IP Office, right-click IP Route from the Navigation pane, and select New. To view or edit an existing route, select IP Route from the Navigation pane, and select the appropriate route from the Group pane. The following screen shows the Details pane with the relevant default route using Destination LAN1.
To facilitate use of Avaya IP Office Softphone, https was enabled in the sample configuration. To check whether https is enabled, navigate to File → Advanced → Security Settings. A screen such as the following is presented. Log in with the appropriate security credentials.

After logging in, select System from the Navigation pane and the appropriate IP Office system from the Group pane. In the Details pane, select the System Details tab. Verify that Allow HTTPS is checked. If not, check the box, click OK, and heed the on-screen prompts and warnings. Note that this action may be service disrupting.
When complete, select **File → Configuration** to return to configuration activities.

### 5.2. Licensing

The configuration and features described in these Application Notes require the IP Office system to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity, contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity, click **License** in the Navigation pane and **SIP Trunk Channels** in the Group pane. Confirm a valid license with sufficient “Instances” (trunk channels) in the Details pane.
If Avaya IP Telephones will be used as is the case in these Application Notes, verify the Avaya IP endpoints license. Click **License** in the Navigation pane and **Avaya IP endpoints** in the Group pane. Confirm a valid license with sufficient “Instances” in the Details pane.

A similar process can be used to check the license status for other desired features. For example, the following screen shows the availability of a valid license for **Mobility Features**. In the sample configuration, various mobility features including Mobile Twinning are used.
The following screen shows the availability of a valid license for **Power User** features. In the sample configuration, the user with extension 30026 will be configured as a “Power User” and will be capable of using the Avaya IP Office Softphone.

### 5.3. System Settings

This section illustrates the configuration of system settings. Select **System** in the Navigation pane to configure these settings. The subsection order corresponds to a left to right navigation of the tabs in the Details pane for system settings.

#### 5.3.1. System Tab

With the proper system name selected in the Group pane, select the **System** tab in the Details pane. The following screen shows a portion of the **System** tab. The **Name** field can be used for
a descriptive name of the system. In this case, the MAC address is used as the name. The **Enable SoftPhone HTTP Provisioning** box is checked to facilitate Avaya IP Office Softphone usage. In the screen shown below, the **Avaya HTTP Clients Only** box is shown un-checked, but this box may be checked after all configurations are complete. During initial configuration of the Avaya 1140E and Avaya 1220 telephones, it may be necessary to leave this box unchecked. In the screen shown below, both the **TFTP Server IP Address** and the **HTTP Server IP Address** contain the IP Office LAN1 address, and the **Phone File Server Type** was set to “Memory Card”. An IP Office memory card can be used as the source for binaries, settings files, and language files for IP Telephones.

### 5.3.2. LAN Settings

In the sample configuration, LAN1 was used to connect the IP Office to the enterprise network. Other LAN choices (e.g., LAN2) may also be used. To view or configure the **IP Address** of LAN1, select the **LAN1** tab followed by the **LAN Settings** tab. As shown in **Figure 1**, the IP Address of the IP Office, known to Verizon Business, is 1.1.1.2. Other parameters on this screen may be set according to customer requirements. In the example screen, the **DHCP Mode** was set to “Server” to allow IP Office to facilitate provisioning for the IP Telephones in the sample configuration.
After setting the **DHCP Mode** to “Server”, the **Advanced** button can be used to configure DHCP settings. In the screen shown below, the **DHCP Pools** tab has been selected and a DHCP pool is shown that is sufficient to support the small number of IP Telephones in the sample configuration. Click **OK**.
Select the **VoIP** tab as shown in the following screen. The **SIP Trunks Enable** box must be checked to enable the configuration of SIP trunks to Verizon Business. The **H323 Gatekeeper Enable** box is checked to allow the use of Avaya IP Telephones using the H.323 protocol, such as the Avaya 1600-Series Telephones used in the sample configuration. The **SIP Registrar Enable** box is checked to allow Avaya IP Office Softphone usage, and Avaya 1140E and Avaya 1220 telephone usage.

If desired, the **RTP Port Number Range** can be customized to a specific range of receive ports for the RTP media paths from Verizon Business to IP Office. That is, for SIP Trunk calls to and from Verizon Business, the SIP protocol exchanges will result in Verizon Business sending RTP media to IP Office using a UDP port in the configurable range shown below.

If desired, IP Office can be configured to mark the Differentiated Services Code Point (DSCP) in the IP Header with specific values to support Quality of Service policies. In the sample configuration shown below, IP Office will mark SIP signaling with a value associated with “Assured Forwarding” using DSCP decimal 28 (**SIG DSCP** parameter). IP Office will mark the RTP media with a value associated with “Expedited Forwarding” using DSCP decimal 46 (**DSCP** parameter). This screen enables flexibility in IP Office DiffServ markings (RFC 2474) to allow alignment with network routing policies, which are outside the scope of these Application Notes. Other parameters on this screen may be set according to customer requirements.
Select the **Network Topology** tab as shown in the following screen. For **Public IP Address**, enter the Avaya IP Office LAN1 IP address. Set the **Public Port** to 5060. In the sample configuration, the **Firewall/NAT Type** is set to “Open Internet”. With this configuration, STUN will not be used. During the testing, the **Binding Refresh Time** was varied (e.g., 30 seconds, 90 seconds to test SIP OPTIONS timing). Click the **OK** button.
Note: The **Firewall/NAT Type** parameter may need to be different, depending on the type of firewall or Network Address Translation device used at the customer premise.

Select the **SIP Registrar** tab. The following screen shows the settings used in the sample configuration. The **Domain Name** has been set to the customer premises equipment domain “adevc.avaya.globalipcom.com” known to Verizon Business. If the **Domain Name** is left at the default blank setting, SIP registrations may use the IP Office LAN1 IP Address. All other parameters shown are default values.

![SIP Registrar settings](image)
5.3.3. Voicemail
To view or change voicemail settings, select the Voicemail tab as shown in the following screen. The settings presented here simply illustrate the sample configuration and are not intended to be prescriptive. The Voicemail Type in the sample configuration is “Voicemail Lite/Pro”. Other Voicemail types may be used. The Voicemail IP Address in the sample configuration is 1.1.1.63, the IP Address of the PC running the Voicemail Pro software, as shown in Figure 1. In the sample configuration, the “Callback” application of Avaya Voicemail Pro was used to allow Voicemail Pro to call out via the SIP Line to Verizon Business when a message is left in a voice mailbox. The SIP Settings shown in the screen below enable IP Office to populate the SIP headers for an outbound “callback” call from Voicemail Pro, similar to the way the fields with these same names apply to calls made from telephone users (e.g., see Section 5.5). Other parameters on this screen may be set according to customer requirements.

5.3.4. System Telephony Configuration
To view or change telephony settings, select the Telephony tab and Telephony sub-tab as shown in the following screen. The settings presented here simply illustrate the sample configuration and are not intended to be prescriptive. In the sample configuration, the Inhibit Off-Switch Forward/Transfer box is unchecked so that call forwarding and call transfer to PSTN destinations via the Verizon Business IP Trunk service can be tested. The Companding
Law parameters are set to “ULAW” as is typical in North American locales. Other parameters on this screen may be set according to customer requirements.

5.3.5. System Twinning Configuration

To view or change Twinning settings, select the Twinning tab as shown in the following screen. The Send original calling party information for Mobile Twinning box is not checked in the sample configuration, and the Calling party information for Mobile Twinning is left blank. With this configuration, and related configuration of “Diversion header” on the SIP Line (Section 5.4), the true identity of a PSTN caller can be presented to the twinning destination (e.g., a user’s mobile phone) when a call is twinned out via the Verizon Business IP Trunk service.

5.4. SIP Line

This section shows the configuration screens for the SIP Line in IP Office Release 7. Since IP Office Release 7 introduced new SIP Line parameters and re-oriented existing parameters, this section has the most substantive changes in these Application Notes, compared to the configuration documented in references [JRR-IPOR6] and [JRR-IPOR61]. The Appendix in
Section 11 contains an example SIP Trunk template file that was generated from the SIP Line configured in this section.

To add a new SIP Line, right click on Line in the Navigation pane, and select New \(\rightarrow\) SIP Line. A new Line Number will be assigned automatically. To edit an existing SIP Line, click Line in the Navigation pane, and the SIP Line to be configured in the Group pane.

### 5.4.1. SIP Line - SIP Line Tab

The **SIP Line** tab in the Details pane is shown below for Line Number 7, used for the Verizon Business IP Trunk service. The **ITSP Domain Name** may be configured to the IP Office LAN1 address (i.e., 1.1.1.2) or the CPE domain known to Verizon (i.e., adevc.avaya.globalipcom.com). IP Office will use this field for the host portion of SIP headers such as the From header. By default, the **In Service** and **Check OOS** boxes are checked. In the sample configuration, IP Office will use the SIP OPTIONS method to periodically check the SIP Line. The time between SIP OPTIONS sent by IP Office will use the **Binding Refresh Time** for LAN1, as shown in Section 5.3.2. See Section 5.10 for additional information related to configuring the periodicity of SIP OPTIONS.

The **Send Caller ID** parameter is set to “Diversion Header”. With this setting and the related configuration in Section 5.3.5, IP Office will include the Diversion Header for calls that are directed via Mobile Twinning out the SIP Line to Verizon. The Diversion Header will contain the number associated with the Twinning user, allowing Verizon to admit the call, and the From Header will be populated with the true calling party identity, allowing the twinning destination (e.g., mobile phone) to see the true caller id. IP Office Release 7 will also include the Diversion header for calls that are call forwarded out the SIP Line to Verizon. The **Call Routing Method** can retain the default “Request URI” setting, or may be changed to “To Header”, to match Incoming Call Routes based on the contents of the “To Header”. Click **OK** (not shown).
The area of the screen entitled REFER Support was first introduced in IP Office Release 6.1. In the following screen, the REFER Support box is checked, and “Always” has been selected from the drop-down menu for the Incoming and Outgoing parameters, to enable use of SIP REFER to Verizon in the sample configuration. Successful testing was also performed with the REFER Support parameters set to “Never”.

The Association Method parameter was introduced in IP Office Release 7.0, and the screen below shows the default value, which is sufficient in the sample configuration. The various alternatives for the Association Method may be useful when multiple SIP Trunks with different SIP domains resolve to a single IP Address. The default option associates incoming requests with SIP Lines by comparing the source IP Address and port of the incoming message against the configured far-end of the SIP Line. The far-end of the SIP Line may be configured using a static IP Address and port, or by using a domain name. If a domain name is used, the source IP address and port of the incoming message is compared with the IP address and port of the far-end, as resolved via DNS. The domain name “pcelban0001.avayalincroft.globalipcom.com” is shown in these Application Notes in the Transport tab in the following section.
5.4.2. SIP Line - Transport Tab
Select the Transport tab. This tab was first introduced in Release 6.1. Some information configured in this tab had been under the SIP Line tab in Release 6.0.

The ITSP Proxy Address is set to the Verizon domain provided by Verizon Business. As shown in Figure 1, this domain is “pcelban0001.avayalincroft.globalipcom.com”. Optionally, the domain configured in the ITSP Proxy Address field can be suffixed with a number. For example, “pcelban0001.avayalincroft.globalipcom.com(4)” may be entered. In the Network Configuration area, UDP is selected as the Layer 4 Protocol. Since DNS SRV will be used, the Send Port can retain the default value 5060. The port to which IP Office sends SIP messages will be determined via the DNS procedures. The Use Network Topology Info parameter is set to “LAN 1”. This associates the SIP Line with the parameters in the System → LAN1 → Network Topology tab. The Explicit DNS Server(s) is configured with the DNS Server IP address provided by Verizon Business, which is 172.30.209.4 in the sample configuration.
5.4.3. SIP Line - SIP URI Tab

Select the SIP URI tab. To add a new SIP URI, click the Add… button. In the bottom of the screen, a New Channel area will be opened. To edit an existing entry, click an entry in the list at the top, and click the Edit… button. In the bottom of the screen, the Edit Channel area will be opened. In the example screen below, the previously configured entry for Channel 1 is edited.

“Use Internal Data” is selected for the Local URI, Contact, and Display Name. Information configured on the SIP Tab for individual users will be used to populate the SIP headers. The PAI parameter was introduced in IP Office Release 6.1, and the value “None” is shown selected from the drop-down menu. With PAI set to “None”, IP Office Release 6.1 and 7.0 will behave like IP Office Release 6.0 with respect to the SIP P-Asserted-Identity header (e.g., IP Office will not include a PAI header for an outbound call unless privacy is asserted). If the optional Verizon “unscreened ANI” feature is configured for the Verizon service, the PAI parameter may be set to the specific Screened Telephone Number (STN) provided by Verizon. The Registration parameter is set to the default “0: <None>” since Verizon IP Trunk service does not require registration. The Incoming Group parameter, set here to 7, will be referenced when configuring Incoming Call Routes to map inbound SIP trunk calls to IP Office destinations in Section 5.7. The Outgoing Group parameter, set here to 8, will be used for routing outbound calls to Verizon via the Short Codes (Section 5.6) or ARS configuration (Section 5.8). The Max Calls per Channel parameter, configured here to 10, sets the maximum number of simultaneous calls that can use the URI before IP Office returns busy to any further calls. Click OK.
In the sample configuration, the single SIP URI shown above was sufficient to allow incoming calls for Verizon DID numbers destined for specific IP Office users or IP Office hunt groups. The calls are accepted by IP Office since the incoming number will match the SIP Name configured for the user or hunt group that is the destination for the call. For service numbers, such as a DID number routed directly to voicemail, or a DID number routed to an auto-attendant service on Voicemail Pro, the DID numbers that IP Office should admit can be entered into the Local URI and Contact fields instead of “Use Internal Data”.

5.4.4. SIP Line - VoIP Tab

Select the VoIP tab. In the sample configuration, the Compression Mode was configured using the Advanced button, allowing an explicit ordered list of codecs to be specified. Place a checkmark next to the G.729(a) 8K CS-ACELP and G.711 ULAW 64K codecs to cause IP Office to include both G.729a and G.711MU in the Session Description Protocol (SDP) offer, in that order. The DTMF Support parameter can remain set to the default value “RFC2833”. The Re-invite Supported parameter should be checked to allow for codec re-negotiation in cases where the target of an incoming call or transfer does not support the codec originally negotiated on the trunk. The Re-invite Supported parameter must also be checked to allow the Fax Transport Support parameter to take on values other than “none”, or to check the Codec Lockdown parameter. The Use Offerer’s Preferred Codec parameter can be left at the default unchecked setting. In the sample configuration, Verizon preferred the G.729a codec in SDP, while also allowing the G.711MU codec. The IP Office configuration shown below matches these Verizon preferences. In the course of testing, the IP Office configuration was varied such that G.711MU was the preferred or only codec listed, and G.711MU calls were also successfully verified. Since the Verizon Business IP Trunk production service did not support T.38 fax, the Fax Transport Support parameter is set to “G.711” rather than “T.38”, and the T38 Fax tab need not be visited. See Section 2.2 for additional fax considerations. The Codec Lockdown parameter, new in IP Office Release 7.0, may be checked or may retain the default unchecked value. The Codec Lockdown parameter can be used to prevent codec ambiguity, should an SDP answer list multiple codecs, which is typically not the case with Verizon. If Codec Lockdown is checked, and an SDP answer with multiple codecs is received, IP Office can initiate a re-INVITE with a single chosen codec. Since the Verizon Business IP Trunk service does not require registration, the SIP Credentials tab need not be visited. Click OK (not shown).
5.5. Users, Extensions, and Hunt Groups

In this section, examples of IP Office Users, Extensions, and Hunt Groups will be illustrated. In the interests of brevity, not all users and extensions shown in Figure 1 will be presented, since the configuration can be easily extrapolated to other users. To add a User, right click on User in the Navigation pane, and select New. To edit an existing User, select User in the Navigation pane, and select the appropriate user to be configured in the Group pane.

5.5.1. User 201

The following screen shows the User tab for User 201. As shown in Figure 1, this user corresponds to the digital telephone 5410.

The following screen shows the SIP tab for User 201. The SIP Name and Contact parameters are configured with the DID number of the user, 7329450231. These parameters configure the user part of the SIP URI in the From header for outgoing SIP trunk calls, and allow matching of the SIP URI for incoming calls, without having to enter this number as an explicit SIP URI for the SIP Line. The SIP Display Name (Alias) parameter can optionally be configured with a descriptive name. If all calls involving this user and a SIP Line should be considered private, then the Anonymous box may be checked to withhold the user’s information from the network. See Section 5.6 for a method of using a short code (rather than static user provisioning) to place an anonymous call.
From **Figure 1**, note that user 201 will use the Mobile Twinning feature. The following screen shows the Mobility tab for User 201. The Mobility Features and Mobile Twinning boxes are checked. The Twinned Mobile Number field is configured with the number to dial to reach the twinned mobile telephone, in this case 917326870755. Other options can be set according to customer requirements.
The following screen shows the Extension information for this user. To view, select **Extension** from the Navigation pane, and the appropriate extension from the Group pane. As stated in Section 5.1, the Avaya 5410 telephone user with extension 201 is connected to port 1 of the digital module.
5.5.2. User 30026

The following screen shows the User tab for User 30026. This user corresponds to an Avaya 1616 IP Telephone that will be granted “Power User” and Avaya IP Office Softphone features. The Profile parameter is set to “Power User”. The Enable Softphone box is checked, along with other advanced capabilities.

Like the user with extension 201, the SIP tab for the user with extension 30026 is configured with a SIP Name and Contact specifying the user’s Verizon Business DID number.

The following screen shows the Voicemail tab for the user with extension 30026. The Voicemail On box is checked, and a voicemail password can be configured using the Voicemail Code and Confirm Voicemail Code parameters. In the verification of these Application Notes,
incoming calls from the Verizon Business IP Trunk to this user were redirected to Voicemail Pro after no answer. Voicemail messages were recorded and retrieved successfully. Voice mail navigation and retrieval were performed locally and from PSTN telephones, to test DTMF using RFC 2833, and to test assignment of a Verizon DID number to the “Voicemail Collect” feature (e.g., via the *17 short code shown in Section 5.6).

Select the **Telephony** tab followed by the **Supervisor Settings** tab as shown below. To allow hot desking, enter a **Login Code**.
Select the **Call Settings** tab as shown below. Check the **Call Waiting On** box to allow an IP Office Softphone logged in as this extension to have multiple call appearances (e.g., necessary for call transfer).

![Call Settings Tab](image)

The following screen shows the **Source Numbers** tab for the user with extension 30026. Although the Voicemail Pro configuration is beyond the scope of these Application Notes, the “Callback” feature has been enabled on Voicemail Pro for this user, and the Source Number “P917326870755” has been previously added. With this configuration, when a message is left in this user’s Voicemail Pro mailbox, a “callback” call will be initiated to “917326870755”. The callback call will be sent to Verizon via SIP Line 7, and the From and Contact headers in the SIP INVITE will be populated with the information configured in the **System → Voicemail** tab shown in Section 5.3.3. It is possible (and more typical) for the end user to configure callback numbers via the Voicemail Pro Telephony User Interface, rather than the administrator configuring a callback number via the “P” Source Number in IP Office, as shown below.

To add a new Source Number, Press the **Add...** button to the right of the list of any previously configured Source Numbers. To edit an existing Source Number, select the Source Number from the list, and click **Edit...** When finished, click **OK**.

![Source Numbers Tab](image)
The following screen shows the Extension information for this user, simply to illustrate the VoIP tab available for an IP Telephone. To view, select **Extension** from the Navigation pane, and the appropriate extension from the Group pane. Select **VoIP** in the Details pane.

![VoIP tab](image_url)
5.5.3. User 235 (Avaya 1140E)

To add a new SIP extension for this user, right click on Extension in the Navigation pane on the left, and select New SIP Extension (not shown). The following screen shows the Extn tab as captured while the extension was in the process of being added. In the Base Extension field, enter the extension of the user, such as “235” shown below. Ensure the Force Authorization box is checked.

The following screen shows the VoIP tab for the extension. The IP Address field can be left blank. Alternatively, the IP Address may be populated with an IP Address to restrict registrations to a specific IP Address. Check the Reserve Avaya IP endpoint license box. Other fields may use default values, as shown below.
The following screen shows the **User** tab for User 235 while the user was being added. This user corresponds to the Avaya 1140E Telephone in the sample configuration. Enter appropriate information into the **Name**, **Full Name**, **Password**, and **Confirm Password** fields. The **Extension** field is populated with 235. After the Avaya 1140E Telephone has registered, the **Device Type** field will update, as illustrated later in this section.

![User tab for User 235](image)

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Nortell 140</td>
</tr>
<tr>
<td>Password</td>
<td>*****</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>*****</td>
</tr>
<tr>
<td>Full Name</td>
<td>Nortell 140</td>
</tr>
<tr>
<td>Extension</td>
<td>235</td>
</tr>
<tr>
<td>Locale</td>
<td>United States (US English)</td>
</tr>
<tr>
<td>Priority</td>
<td>5</td>
</tr>
<tr>
<td>System Phone Rights</td>
<td>None</td>
</tr>
<tr>
<td>Profile</td>
<td>Basic User</td>
</tr>
<tr>
<td>Device Type</td>
<td>All Other Phone Types</td>
</tr>
</tbody>
</table>
Select the **Telephony** tab. Select the **Supervisor Settings** tab as shown below. Enter a **Login Code** that will be used by the Avaya Nortel 1140E as the login password.

![Telephony Settings](image)

Remaining in the **Telephony** tab, select the **Call Settings** tab as shown below. Check the **Call Waiting On** box to allow multiple call appearances and transfer operations.

![Call Settings](image)

Like other users previously illustrated, the **SIP** tab for the user with extension 235 is configured with a **SIP Name** and **Contact** specifying the user’s Verizon Business DID number.
After the Avaya 1140E has registered as extension 235, the User details screen updates the **Device Type** to show an “Avaya 1140E Sip” as shown in the screen below.

5.5.4. User 238 (Avaya 1220)

To add a new SIP extension for this user, right click on Extension in the Navigation pane on the left, and select New SIP Extension (not shown). The following screen shows the **Extn** tab as captured while the extension was in the process of being added. In the **Base Extension** field,
enter the extension of the user, such as “238” shown below. Ensure the **Force Authorization** box is checked.

The following screen shows the **VoIP** tab for the extension. The **IP Address** field can be left blank as shown below. Alternatively, the **IP Address** may be populated with an IP Address to restrict registrations to a specific IP Address. Check the **Reserve Avaya IP endpoint license** box. Other fields may use default values, as shown below.
The following screen shows the **User** tab for User 238 while the user was being added. This user corresponds to the Avaya 1220 Telephone in the sample configuration. Enter appropriate information into the **Name**, **Full Name**, **Password**, and **Confirm Password** fields. The **Extension** field is populated with 238. After the Avaya 1220 Telephone has registered, the **Device Type** field will update, as illustrated later in this section.
Select the **Telephony** tab. Select the **Supervisor Settings** tab as shown below. Enter a **Login Code** that will be used by the Avaya Nortel 1220 as the login password.

Remaining in the **Telephony** tab, select the **Call Settings** tab as shown below. Check the **Call Waiting On** box to allow multiple call appearances and transfer operations.

Like other users previously illustrated, the **SIP** tab for the user with extension 238 is configured with a **SIP Name** and **Contact** specifying the user’s Verizon Business DID number.
After the Avaya 1220 has registered as extension 238, the User screen updates the Device Type to show an “Avaya 1220 Sip” as shown in the screen below.
5.5.5. Hunt Groups

During the verification of these Application Notes, users could also receive incoming calls as members of a hunt group. To configure a new hunt group, right-click HuntGroup from the Navigation pane, and select New. To view or edit an existing hunt group, select HuntGroup from the Navigation pane, and the appropriate hunt group from the Group pane.

The following screen shows the Hunt Group tab for hunt group 200. This hunt group was configured to contain the two digital telephones x201 and x203 in Figure 1. These telephones will both ring when the hunt group number is called, due to the Ring Mode setting “Collective”. Click the Edit button to change the User List.

The following screen shows the SIP tab for hunt group 200. The SIP Name and Contact are configured with Verizon DID 7329450236. Later, in Section 5.7, an Incoming Call Route will map 7329450236 to this hunt group.
The following screen shows the **Hunt Group** tab for another hunt group 30200. This hunt group was configured to contain the two IP telephones x30025 and x30026 in **Figure 1**. These telephones will ring sequentially when the hunt group number is called, due to the **Ring Mode** setting “Sequential”. That is, extension 30025 will ring first. If unanswered, extension 30026 will ring, and so on (for larger groups).

![Hunt Group Tab](image1)

The following screen shows the **SIP** tab for hunt group 30200. The **SIP Name** and **Contact** are configured with Verizon DID 7329450237. Later, in Section 5.7, an incoming call route will map this same Verizon DID number to this hunt group.

![SIP Tab](image2)
5.6. Short Codes

In this section, various examples of IP Office short codes will be illustrated. To add a short code, right click on Short Code in the Navigation pane, and select New. To edit an existing short code, click Short Code in the Navigation pane, and the short code to be configured in the Group pane.

In the screen shown below, the short code “9N;” is illustrated. The Code parameter is set to “9N;”. The Feature parameter is set to “Dial”. The Telephone Number parameter is set to N”@Domain Name or IP Address of Verizon Business IP Trunk Service” with the text string beginning with @ in quotes. Below, the Verizon provided domain shown in Figure 1 is configured. The Telephone Number field is used to construct the Request URI and To Header in the outgoing SIP INVITE message. The Line Group ID parameter is set to 8, matching the number of the Outgoing Group configured on the SIP URI tab of SIP Line 7 to Verizon Business (Section 5.4).

This simple short code will allow an IP Office user to dial the digit 9 followed by any telephone number, symbolized by the letter N, to reach the SIP Line to Verizon business. N can be any number such as a 10-digit number, a 1+10 digit number, a toll free number, directory assistance (e.g., 411), etc. This short code approach has the virtue of simplicity, but does not provide for alternate routing or an awareness of end of user dialing. When a user dials 9 plus the number, IP Office must wait for an end of dialing timeout before sending the SIP INVITE to Verizon Business. Click the OK button (not shown).

Optionally, add or edit a short code that can be used to access the SIP Line anonymously. In the screen shown below, the short code “8N;” is illustrated. This short code is similar to the “9N;” short code except that the Verizon IP Address rather than the domain is entered in the Telephone Number field. This is done for variety; either method can be used. The Telephone Number field begins with the letter W, which means “withhold the outgoing calling line identification”.

![Sequential Group IP Stations Seq: 30200](image)

![IP Offices](image)

![Short Code](image)

![9N:: Dial](image)
In the case of the SIP Line to Verizon documented in these Application Notes, when a user dials 8 plus the number, IP Office will include the user’s telephone number in the P-Asserted-Identity (PAI) header along with “Privacy: Id”. Verizon will allow the call due to the presence of a valid DID in the PAI header, but will prevent presentation of the caller id to the called PSTN destination.

The simple “9N;” and “8N;” short codes illustrated previously do not provide a means of alternate routing if the primary Verizon SIP line is out of service or temporarily not responding. When alternate routing options and/or more customized analysis of the digits following the short code are desired, the Automatic Route Selection (ARS) feature may be used. In the following example screen, the short code 7N is illustrated for access to ARS. When the IP Office user dials 7 plus any number N, rather than being directed to a specific Line Group Id, the call is directed to Line Group ID “50: Main”, configurable via ARS. See Section 5.8 for example ARS route configuration for “50: Main” as well as a backup route.

The following screen illustrates a short code that acts like a feature access code rather than a means to access a SIP Line. In this case, the Code “#17” is defined for Feature “Voicemail Collect”. This short code will be used as one means to allow a Verizon DID to be programmed to route directly to voice messaging, via inclusion of this short code as the destination of an Incoming Call Route. See Section 5.7.
The following screen illustrates another short code that acts like a feature access code rather than a means to access a SIP Line. In this case, the Code “*99” is defined for Feature “Voicemail Collect” and Telephone Number “Attendant”. This short code will be used as a means to allow a Verizon DID to be programmed to route directly to a Voicemail Pro “Attendant” (auto-attendant) application, via inclusion of this short code as the destination of an Incoming Call Route. See Section 5.7.

![Screen illustrating *99: Voicemail Collect](image)

### 5.7. Incoming Call Routes

In this section, IP Office Incoming Call Routes are illustrated. Each Incoming Call Route will map a specific Verizon Business DID number to a destination user, group, or function on IP Office. To add an incoming call route, right click on **Incoming Call Route** in the Navigation pane, and select **New**. To edit an existing incoming call route, select **Incoming Call Route** in the Navigation pane, and the appropriate incoming call route to be configured in the Group pane.

In the screen shown below, the incoming call route for **Incoming Number** “7329450231” is illustrated. The **Line Group Id** is 7, matching the **Incoming Group** field configured in the SIP URI tab for the SIP Line to Verizon Business in Section 5.4.
Select the **Destinations** tab. From the **Destination** drop-down, select the extension to receive the call when a PSTN user dials 7329450231. As shown in **Table 1**, 7329450231 is the DID number associated with IP Office user extension 201.

In the screen shown below, the incoming call route for **Incoming Number** “7329450229” is illustrated. The **Line Group Id** is 7, matching the Incoming Group field configured in the SIP URI tab for the SIP Line to Verizon Business in Section 5.4.

Select the **Destinations** tab. From the **Destination** drop-down, select the extension to receive the call when a PSTN user dials 7329450229. As shown in **Table 1**, 7329450229 is the DID number associated with IP Office user extension 30026.
The Incoming Call Routes directing calls to the Avaya 1140E and Avaya 1220 Telephones are configured similarly. For example, in the screen shown below, the incoming call route for **Incoming Number** “7329450285” is illustrated. The **Line Group Id** is 7, matching the Incoming Group field configured in the SIP URI tab for the SIP Line to Verizon Business in Section 5.4.

Select the **Destinations** tab. From the **Destination** drop-down, select the extension to receive the call when a PSTN user dials 7329450285. As shown in **Table 1**, 7329450285 is the DID number associated with IP Office user extension 235, the Avaya 1140E.

Incoming Call Routes for other direct mappings of DID numbers to IP Office users listed in **Table 1** are omitted here, but can be configured in the same fashion.

In the screen shown below, the incoming call route for **Incoming Number** “7329450236” is illustrated. The **Line Group Id** is 7, matching the Incoming Group field configured in the SIP URI tab for the SIP Line to Verizon Business in Section 5.4.
Select the **Destinations** tab. From the **Destination** drop-down, select the extension to receive the call when a PSTN user dials 7329450236. In this case, the destination is the hunt group “200 Main” whose configuration is shown in Section 5.5.3.

In the screen shown below, the incoming call route for **Incoming Number** “7329450237” is illustrated. The **Line Group Id** is 7, matching the Incoming Group field configured in the SIP URI tab for the SIP Line to Verizon Business in Section 5.4.
Select the **Destinations** tab. From the **Destination** drop-down, select the extension to receive the call when a PSTN user dials 7329450237. In this case, the destination is the hunt group “30200 IP Stations Seq” whose configuration is shown in Section 5.5.3.

When configuring an Incoming Call Route, the **Destination** field can be manually configured with a number such as a short code, or certain keywords available from the drop-down list. For example, the following **Destinations** tab for an incoming call route contains the **Destination** “*17” entered manually. The dial string “*17” is the short code for “Voicemail Collect”, as shown in Section 5.6. An incoming call to 732-945-0234 will be delivered directly to voicemail, allowing the caller to log-in to voicemail and access messages.

Similar, the following **Destinations** tab for an incoming call route contains the **Destination** “*99” entered manually. The dial string “*99” is the short code for accessing the “Attendant” application on Voicemail Pro, as shown in Section 5.6. An incoming call to 732-945-0228 will be delivered directly to the Voicemail Pro “Attendant” application, which will allow the caller to be prompted with announcements, navigate via DTMF, and transfer to IP Office users. The configuration of the “Attendant” application on Voicemail Pro is outside the intended scope of these Application Notes.

### 5.8. ARS and Alternate Routing

While detailed coverage of ARS is beyond the scope of these Application Notes, this section includes basic ARS screen illustrations and considerations. ARS is illustrated here mainly to illustrate alternate routing should the SIP Line be out of service or temporarily not responding.

Optionally, Automatic Route Selection (ARS) can be used rather than the simple “9N;” short code approach documented in Section 5.6. With ARS, secondary dial tone can be provided after the access code, time-based routing criteria can be introduced, and alternate routing can be specified so that a call can re-route automatically if the primary route or outgoing line group is
not available. Although not shown in this section, ARS also facilitates more specific dialed telephone number matching, enabling immediate routing and alternate treatment for different types of numbers following the access code. For example, if all 1+10 digit calls following an access code should use the SIP Line preferentially, but other local or service numbers following the access code should prefer a different outgoing line group, ARS can be used to distinguish the call behaviors.

To add a new ARS route, right-click ARS in the Navigation pane, and select New. To view or edit an existing ARS route, select ARS in the Navigation pane, and select the appropriate route name in the Group pane.

The following screen shows an example ARS configuration for the route named “Main”. The In Service parameter refers to the ARS form itself, not the Line Groups that may be referenced in the form. If the In Service box is un-checked, calls are routed to the ARS route name specified in the Out of Service Route parameter. IP Office short codes may also be defined to allow an ARS route to be disabled or enabled from a telephone. The configurable provisioning of an Out of Service Route, and the means to manually activate the Out of Service Route can be helpful for scheduled maintenance or other known service-affecting events for the primary route.

Assuming the primary route is in-service, the number passed from the short code used to access ARS (e.g., 7N in Section 5.6) can be further analyzed to direct the call to a specific Line Group ID. Per the example screen above, if the user dialed 7-1-908-848-5704, the call would be directed to Line Group 18, another SIP Line that exists in the configuration that is not described in these Application Notes. If Line Group 18 cannot be used, the call can automatically route to the route name configured in the Additional Route parameter in the lower right of the screen. Since alternate routing can be considered a privilege not available to all callers, IP Office can control access to the alternate route by comparing the calling user’s priority to the value in the Alternate Route Priority Level field.
The following screen shows an example ARS configuration for the route named “backup”, ARS Route ID 51. Continuing the example, if the user dialed 7-1-908-848-5704, and the call could not be routed via the primary route “50: Main” described above, the call will be delivered to this “backup” route. Per the configuration shown below, the call will be delivered to Line Group 8, using the SIP Line to Verizon Business IP Trunk service described in these Application Notes. The configuration of the Code, Telephone Number, Feature, and Line Group ID for an ARS route is similar to the configuration already shown for short codes in Section 5.6. In this case, the originally dialed number (sans the short code 7) is delivered in the Request URI along with the Verizon FQDN (i.e., the contents of the INVITE sent to Verizon are the same as the 9-1-908-848-5704 short code 9 approach from Section 5.6). Additional codes (e.g., 411, 0+10, etc.) can be added to the ARS route by pressing the Add… button to the right of the list of previously configured codes.

In the testing associated with the configuration, calls were successfully delivered to SIP Line 8 via both the primary ARS route “50: Main” (via changes to “50: Main”) as well as the backup ARS route shown above. If a primary route experiences a network outage such that no response is received to an outbound INVITE, IP Office successfully routes the call via the backup route. The user receives an audible tone when the re-routing occurs and may briefly see “Waiting for Line” on the display. The testing verified that the INVITE was sent to the primary route, and the call re-routed upon timeout. The call was made right after a failure of the primary route was induced, so IP Office had not yet marked the SIP Line out of service as a result of no response to SIP OPTIONS. Testing also verified that calls can be delivered to Verizon via the alternate route when the primary route was manually marked out-of-service, or known to be out-of-service due to prior failure of SIP OPTIONS.
5.9. Privacy / Anonymous Calls

As described in Section 5.6, an IP Office user whose calling line identification is not typically withheld from the network can request privacy in the sample configuration by dialing the short code 8 to access the SIP Line. The Avaya 1600-Series IP Telephones can also request privacy, without dialing a unique short code, using Features  Call Settings  Withhold Number. The Withhold Number parameter may be set to “On” (i.e., for privacy). Specific users may be configured to always withhold calling line identification by checking the Anonymous field in the SIP tab for the user (Section 5.5).

To configure IP Office to include the caller’s DID number in the P-Asserted-Identity SIP header, required by Verizon Business to admit an otherwise anonymous caller to the network, the following procedure may be used.

From the Navigation pane, select User. From the Group pane, scroll down past the configured users and select the user named NoUser. From the NoUser Details pane, select the tab Source Numbers. Press the Add… button to the right of the list of any previously configured Source Numbers. In the Source Number field shown below, type SIP_USE_PAIFOR_PRIVACY. Click OK.

The source number SIP_USE_PAIFOR_PRIVACY should now appear in the list of Source Numbers as shown below.

5.10. SIP Options Frequency

In Section 5.4, the SIP Line to Verizon Business is shown with the Check OOS box checked. In the sample configuration, IP Office periodically checks the health of the SIP Line by sending a SIP OPTIONS message. If there is no response, IP Office can mark the trunk out of service. Although ARS as shown in Section 5.8 can include alternate routes to complete calls even if the far-end is not responding, IP Office must wait for the outbound INVITE to timeout before route advance. Once the SIP OPTIONS maintenance recognizes that the SIP Line is out-of-service, new calls will no longer be delayed before route advance. Also, once the problem with the SIP
Line is resolved, the SIP OPTIONS maintenance will automatically bring the link back to the in-service state.

If a customer wishes to control how often SIP OPTIONS messages are sent by IP Office, a NoUser Source Number can be configured as follows. This configuration complements the configuration presented in Section 5.3.2 and Section 5.4.

From the Navigation pane, select User. From the Group pane, scroll down past the configured users and select the user named NoUser. From the NoUser Details pane, select the tab Source Numbers. Press the Add… button to the right of the list of any previously configured Source Numbers. In the Source Number field shown below, type SIP_OPTIONS_PERIOD=X. X is a value (in minutes) representing a longer time than the interval configured (in seconds) in the Binding Refresh Time. In the sample configuration, the value used for X was 2 minutes. Click OK.

The source number SIP_OPTIONS_PERIOD=2 should now appear in the list of Source Numbers as shown below.

With this configuration, a Binding Refresh Time of 30 seconds and a Binding Refresh Time of 90 seconds were tested successfully. That is, IP Office sourced SIP OPTIONS every 30 or 90 seconds, depending on the value configured in the Binding Refresh Time, since the Binding Refresh Time was less than the value configured via the SIP_OPTIONS_PERIOD source number.

5.11. Saving Configuration Changes to IP Office
When desired, send the configuration changes made in IP Office Manager to the IP Office server, to cause the changes to take effect. Click the “disk” icon that is the third icon from the left (i.e., common “save” icon with mouse-over help “Save Configuration File”). Click Yes to validate the configuration, if prompted.
Once the configuration is validated, a screen similar to the following will appear, with either “Merge” or “Immediate” selected, based on the nature of the configuration changes made since the last save. Note that clicking **OK** may cause a service disruption. Click **OK** if desired.
6. Configure Avaya 1140E and Avaya 1220 Telephone

Configuration details for the Avaya 1100-Series and Avaya 1200-Series telephones with IP Office are beyond the scope of these Application Notes. Please consult reference [IPO-11001200] for details. This section summarizes basic information that may be useful to the reader.

The Avaya 1140E and Avaya 1220 used in the sample configuration in these Application Notes were previously being used in a configuration where the phones were running the SIP protocol and registered to an Avaya CS1000 system. As recommended in reference [IPO-11001200], the telephones were reset to factory defaults. The command **73639[MAC]## can be entered via the telephone to reset to factory defaults, where [MAC] is the MAC Address of the telephone, with the number 2 replacing A/B/C in the MAC address and the number 3 replacing D/E/F. After the phone is reset to factory defaults, the default administration password will be 26567*738. The administration password may be required to configure telephone parameters from the telephone.

The procedure outlined in reference [IPO-11001200] can be used to configure the telephone with the basic network information (e.g., DHCP or static IP Address, netmask, default gateway) to communicate with IP Office. IP Office becomes the provisioning server for the phones. Once the telephone contacts IP Office, a new SIP binary, settings file, dialplan file, and language files may be downloaded to the phone from IP Office. When the telephones present a login interface, the user can log in with the user extension and password configured in Section 5.5.3 or 5.5.4.
7. Verizon Business Configuration

Information regarding Verizon Business IP Trunk service offer can be found by contacting a Verizon Business sales representative, or by visiting http://www.verizonbusiness.com/us/products/voip/trunking/.

The reference configuration described in these Application Notes was located in the Avaya Solutions and Interoperability Test Lab. The Verizon Business IP trunk service was accessed via a Verizon Private IP (PIP) T1 connection. Verizon Business provided the necessary service provisioning.

The following Fully Qualified Domain Names (FQDNs) were provided by Verizon for the reference configuration.

<table>
<thead>
<tr>
<th>CPE (Avaya)</th>
<th>Verizon Network</th>
</tr>
</thead>
<tbody>
<tr>
<td>adevc.avaya.globalipcom.com</td>
<td>pcelban0001.avayalincroft.globalipcom.com</td>
</tr>
</tbody>
</table>

For service provisioning, Verizon will require the customer IP address used to reach the Avaya IP Office server. Verizon provided the following information for the compliance testing: the IP address and port used by the Verizon SIP SBC, and the Direct Inward Dialed (DID) numbers shown in Figure 1 and Table 1. This information was used to complete the Avaya IP Office configuration shown in Section 5.
8. Verification Steps
This section illustrates means to verify the configuration besides simply making the types of calls detailed in Section 2.1.

8.1. System Status Application
The System Status application can be used to monitor or troubleshoot IP Office. The System Status application can typically be accessed from Start → Programs → IP Office → System Status. See reference [IPO-SYSSTAT] for more information. The following screen shows an example Logon screen. Enter the IP Office IP address in the Control Unit IP Address field, and enter an appropriate User Name and Password. Click Logon.

The Navigation pane allows various views into the system status. The following screen shows an example Extension Summary report, accessible by selecting Extensions from the Navigation pane as shown below.
At the time this Extension Summary was captured, an IP Office Softphone was logged in as user 30026, causing the Avaya 1616 telephone that had been logged in as 30026 to enter “NoUser” mode (as expected). This can be observed in the last two rows below. In the final row, note that the Telephone Type for the Avaya IP Office Softphone logged in as Current User Extension 30026 is shown as “SIP Softphone”, with an arbitrary Home Extension Number.

The Nortel 1140E is logged in as extension 235 and the Nortel 1220 is logged in as extension 238. The other telephones shown in Figure 1 in Section 3 can also be observed.

<table>
<thead>
<tr>
<th>Home Extension Number</th>
<th>Current User Extension</th>
<th>Current User Name</th>
<th>Module/Slot/IP Address</th>
<th>Port Number/MAC Address</th>
<th>Telephone Type</th>
<th>Number of New Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td>201</td>
<td>201</td>
<td>Extra201</td>
<td>Slot: 3</td>
<td>1</td>
<td>NoUser</td>
<td>0</td>
</tr>
<tr>
<td>202</td>
<td></td>
<td></td>
<td>Slot: 3</td>
<td>2</td>
<td>NoUser</td>
<td>0</td>
</tr>
<tr>
<td>203</td>
<td>203</td>
<td>Extra203</td>
<td>Slot: 3</td>
<td>3</td>
<td>2410</td>
<td>0</td>
</tr>
<tr>
<td>204</td>
<td></td>
<td></td>
<td>Slot: 3</td>
<td>4</td>
<td>Unplugged</td>
<td>0</td>
</tr>
<tr>
<td>205</td>
<td></td>
<td></td>
<td>Slot: 3</td>
<td>5</td>
<td>Unplugged</td>
<td>0</td>
</tr>
<tr>
<td>206</td>
<td></td>
<td></td>
<td>Slot: 3</td>
<td>6</td>
<td>Unplugged</td>
<td>0</td>
</tr>
<tr>
<td>207</td>
<td></td>
<td></td>
<td>Slot: 3</td>
<td>7</td>
<td>Unplugged</td>
<td>0</td>
</tr>
<tr>
<td>208</td>
<td></td>
<td></td>
<td>Slot: 3</td>
<td>8</td>
<td>Unplugged</td>
<td>0</td>
</tr>
<tr>
<td>209</td>
<td>209</td>
<td>JusteFax</td>
<td>Slot: 4</td>
<td>1</td>
<td>POT (C1 Off)</td>
<td>0</td>
</tr>
<tr>
<td>210</td>
<td>210</td>
<td>Extra210</td>
<td>Slot: 4</td>
<td>2</td>
<td>POT (C1 Off)</td>
<td>0</td>
</tr>
<tr>
<td>211</td>
<td>211</td>
<td>Extra211</td>
<td>Slot: 4</td>
<td>3</td>
<td>POT (C1 Off)</td>
<td>0</td>
</tr>
<tr>
<td>212</td>
<td>212</td>
<td>Extra212</td>
<td>Slot: 4</td>
<td>4</td>
<td>POT (C1 Off)</td>
<td>0</td>
</tr>
<tr>
<td>213</td>
<td>213</td>
<td>Extra213</td>
<td>Slot: 4</td>
<td>5</td>
<td>POT (C1 Off)</td>
<td>0</td>
</tr>
<tr>
<td>214</td>
<td>214</td>
<td>Extra214</td>
<td>Slot: 4</td>
<td>6</td>
<td>POT (C1 Off)</td>
<td>0</td>
</tr>
<tr>
<td>215</td>
<td>215</td>
<td>Extra215</td>
<td>Slot: 4</td>
<td>7</td>
<td>POT (C1 Off)</td>
<td>0</td>
</tr>
<tr>
<td>216</td>
<td>216</td>
<td>Extra216</td>
<td>Slot: 4</td>
<td>8</td>
<td>POT (C1 Off)</td>
<td>0</td>
</tr>
<tr>
<td>235</td>
<td>235</td>
<td>Nortel1140</td>
<td>1.1.1.111</td>
<td>1140E SIP</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>259</td>
<td>259</td>
<td>Nortel1220</td>
<td>1.1.1.113</td>
<td>1220E SIP</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>30025</td>
<td>30025</td>
<td>Extra00025</td>
<td>1.1.1.113</td>
<td>00-07-38-FF-22-0D</td>
<td>1616</td>
<td>0</td>
</tr>
<tr>
<td>30026</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>NoUser</td>
<td>0</td>
</tr>
<tr>
<td>50002</td>
<td>50002</td>
<td>Extra00026</td>
<td>1.1.1.63</td>
<td>SIP Softphone</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
Since reference [JRR-IPOR6] contains example System Status screens using digital and H.323 telephones, this section will instead show examples using an Avaya telephone that uses the SIP protocol. The following screen, accessed using Extension ➔ 238, shows status for the Avaya 1220 telephone at the time that the telephone was active on an outbound call to the Verizon IP Trunk Service. In this case, the Codec is G.729A.
The following screen shows call details for this same call. This screen is accessible by clicking on the row of information at the bottom of the screen beginning with column “Call Ref” in the prior screen. In the Originator area, the Dialed Digits “919088485704” can be observed. In the Destination area, it can be observed that the call is using Line 7, the SIP Line configured in Section 5.4.

### Call Details

<table>
<thead>
<tr>
<th>Call Ref: S</th>
<th>Call length: 00:01:57</th>
</tr>
</thead>
</table>

**Originator**

- Current State: Connected
- Time in State: 00:01:54
- Currently at: Extn 238, Nortel1220
- Round Trip Delay: 12ms
- Transmit jitter: 0ms
- Transmit Packet Loss Fraction: 0%
- Dialed Digits: 919088485704
- Codec: G729 A

**Destination**

- Current State: Connected
- Time in State: 00:01:54
- Trunk Used: Line: 7 SIP sdeyc.avaya.globalcom.com Group: 0 Channel: 1
- Digits sent to Central Office: 19088485704@pcebar0001.avayaimc0ft.globalcom.com
- Caller ID sent from Central Office: 919088485704
- Codec: G729 A

**Call target / Routing information**

- Short Code matched: 9N; Dial, System
- RTP Connection Type: RTP Relay
- Call Recording: No
- Redirected to Twns: No
- Routed across SCN trunk: No
- Retargeting Count: 0

Similar procedures may be used to verify details on incoming calls using System Status.

**8.2. System Monitor Application**

The System Monitor application can also be used to monitor or troubleshoot. The System Monitor application can typically be accessed from Start → Programs → IP Office → Monitor. See reference [IPO-MON] for more information.

The application allows the monitored information to be customized. To customize, select the button that is third from the right in the screen below, or select Filters → Trace Options.
The following screen shows the SIP tab, allowing configuration of SIP monitoring. In this example, the SIP Rx and SIP Tx boxes are checked. All SIP messages will appear in the trace with the color blue. To customize the color, right-click on SIP Rx or SIP Tx and select the desired color.
As an example, the following shows a portion of the monitoring window for an outbound call from extension 238, whose Verizon DID is 732-945-0286, calling out to the PSTN via the Verizon IP Trunk Service. The telephone user dialed 9-1-908-848-5704.

```
1058133ewh SIP Tx: UDP 1.1.1.1:5060 -> 172.30.209.21:5071
INVITE sip:1908885704@pceebam001.avayalincroft.globalpcom.com SIP/2.0
Via: SIP/2.0/UDP 1.1.1.1:5060;branch=z9hG4bKw1.1517.e5805c3d93dfc8ef188920a80
From: "Wortel1220" <sip:732450286@avaya.globalpcom.com>;tag=936986346ed
To: sip:1908885704@pceebam001.avayalincroft.globalpcom.com;
Call-ID: 5671525bb3243e45509f045e99ef1f8@1.1.1.2
CSeq: 1115243748 INVITE
Contact: "Wortel1220" <sip:732450286@1.1.1.1:5060;transport=udp>
Max-Forwards: 70
Allow: INVITE, ACK, CANCEL, OPTIONS, BYE, REFER, NOTIFY, INFO, UPDATE
Content-Type: application/sdp
Supported: tinf
Content-Length: 244
v=0
o=UserA 3215522165 2766399843 IN IP4 1.1.1.2
s=Session SDP
c=IN IP4 1.1.1.2
t=0 0
a=msid-0 40152 777798510 18 0 101
a=rtpmap:18 0 8000
a=fmtp:18 annexb=0
a=rtpmap:0 PCMU/8000
a=rtpmap:101 telephone-event/8000
a=fmtp:101 0-15
```

As another example, the following shows a portion of the monitoring window for an inbound call to extension 238, where PSTN telephone 908-848-5704 dialed Verizon DID 732-945-0286.

```
1079393ewh SIF Rx: UDP 172.30.209.21:5071 -> 1.1.1.1:5060
INVITE sip:732450286@1.1.1.1:5060 SIP/2.0
Via: SIP/2.0/UDP 172.30.209.21:5071;branch=z9hG4bKw1.1517.e5805c3d93dfc8ef188920a80
From: "AVAYA ALPHA" <sip:9088885704@48.5.211.120.226@user-phonatoip13670c077-129769764394-70;Lincroft Lab LICROFT Lab> <sip:732450286@avaya.globalpcom.com>;tag=133670c077-129769764394-70
To: "Lincroft Lab LICROFT Lab" <sip:732450286@avaya.globalpcom.com>
Call-ID: 508708301934142131399858021265.211.120.226
CSeq: 308760272 INVITE
Contact: <sip:9088885704@172.30.209.21:5071;transport=udp>
Allow: ACK,BYE,CANCEL,INFO,INVITE,OPTIONS,PRACK,REFER,NOTIFY
Accept: multipart/mixed,application/media_control+xml,application/sdp
Supported: Nat-Forwards: 69
Content-Type: application/sdp
Content-Length: 209
v=0
o=Broa200ck 207408236 1 IN IP4 172.30.209.132
s=--
c=IN IP4 172.30.209.132
t=0 0
a=audio 10128 PTT/AVP 18 0 8 101
a=rtpmap:101 telephone-event/8000
a=fmtp:101 0-15
a=ptime:20
a=fmtp:18 annexb=0
```
8.3. REFER Testing

IP Office Release 6.0 was not certified to use REFER with Verizon IP Trunk Service. Therefore, this section elaborates on the use of REFER, which may now be configured to be used. The following scenarios will result in IP Office sending REFER to the Verizon network. Each scenario was tested successfully.

- PSTN user makes call to Verizon IP Trunk DID and IP Office user answers. IP Office user performs an attended transfer of the inbound call to a PSTN destination using the Verizon IP Trunk service. In this context, an attended transfer implies that the destination of the outbound call answers before the IP Office user completes the transfer. In terms of SIP signaling, this means that IP Office sends the REFER after the 200 OK is received from Verizon.

- IP Office user makes an outbound call to the PSTN via the Verizon IP Trunk service. The IP Office user then performs an attended transfer of the call to another PSTN destination using the Verizon IP Trunk service. In this context, an attended transfer implies that the destination of the outbound call answers before the IP Office user completes the transfer. In terms of SIP signaling, this means that IP Office sends the REFER after the 200 OK is received from Verizon.

- PSTN user makes call to Verizon IP Trunk DID and an IP Office digital or H.323 telephone user answers. The IP Office user performs an unattended transfer of the inbound call to a PSTN destination using the Verizon IP Trunk service. In this context, an unattended transfer implies that the destination of the outbound call does not answer before the IP Office user completes the transfer. In terms of SIP signaling, this means that IP Office sends the REFER after a message such as 183 Session Progress is received from Verizon but before a 200 OK is received from Verizon.

- An IP Office digital or H.323 telephone user makes an outbound call to the PSTN via the Verizon IP Trunk service. The IP Office user performs an unattended transfer of the call to another PSTN destination using the Verizon IP Trunk service. In this context, an unattended transfer implies that the destination of the outbound call does not answer before the IP Office user completes the transfer. In terms of SIP signaling, this means that IP Office sends the REFER after a message such as 183 Session Progress is received from Verizon but before a 200 OK is received from Verizon.
8.3.1. Wireshark Trace Illustration for REFER-Transfer

This section illustrates the SIP signaling for an inbound Verizon IP Trunk call that is transferred back to the PSTN by an IP Office user. IP Office will use SIP REFER.

The following screen shows the portion of the trace up to the point where the IP Office user answers the inbound call. Frame 5 is selected and expanded to show the contents of the INVITE message from Verizon. In frame 8, IP Office answers the call with a 200 OK.
After answering the inbound call, the IP Office digital telephone user presses the transfer button, and dials the number 9-1-732-687-0755 which is routed by IP Office to the Verizon IP Trunk service. In this “attended transfer” example, the IP Office user performing the transfer waits for the outbound call to be answered before pressing the transfer button a second time to complete the transfer.

Scrolling down in the same trace in the screen below, frame 1805 is selected to show the contents of an outbound INVITE sent by IP Office to the Verizon IP Trunk service. In frame 3327, Verizon sends the 200 OK when the called party answers the call.
In this example, after the called party answers, the IP Office digital telephone user presses the transfer button a second time to complete the transfer. Scrolling down in the same trace in the screen below, frame 6262 is selected to show the contents of a REFER message sent by IP Office to the Verizon IP Trunk service. The REFER contains the Call-ID of the outbound call from IP Office to Verizon, and the Refer-To header “Replaces” contains the Call-ID, to-tag, and from-tag, associated with the original inbound call from Verizon. In frame 6283, Verizon sends a 202 Accepted for the REFER.

In frame 6285 expanded below, Verizon sends a BYE for the Call-ID associated with the outbound call to the transferred-to party. In frame 6287, IP Office sends 200 OK to the BYE.

In frame 6288 expanded below, Verizon sends a BYE for the Call-ID associated with the original inbound call from Verizon to IP Office. The two IP Office trunks are cleared, and the PSTN caller (908-848-5704) is speaking with the transferred-to destination (732-687-0755).
8.4. DNS SRV Testing

IP Office Release 6.0 did not support DNS SRV and DNS SRV was not used with Verizon IP Trunk Service. Therefore, this section elaborates on the use of DNS SRV, which may now be configured to be used. The IP Office capability to determine the Verizon SIP signaling address and port using DNS procedures was tested using the production Verizon PIP circuit. Rather than statically configure IP Office with the Verizon IP Address and SIP signaling port, as was the case shown in reference [JRR-IPOR6], IP Office determined the Verizon IP Address and signaling port dynamically using DNS. On the production circuit used for testing, Verizon responded with one “answer”.

8.4.1. Wireshark Trace Illustration for DNS SRV

This section illustrates the DNS signaling used when the SIP Line in IP Office is configured to use DNS SRV. Please reference Section 5.4 of these Application Notes for the relevant configuration. In the filtered Wireshark trace shown below, IP Office (1.1.1.2) sends a DNS SRV query to the Verizon DNS server (172.302.209.4) configured in IP Office for the SIP Line. Frame 35 is highlighted and expanded. Note that the query contains “_sip._udp.pcelban0001.avayalincroft.globalipcom.com” because the IP Office SIP Line has been configured with “pcelban0001.avayalincroft.globalipcom.com” as the Verizon domain, using UDP for transport.
The Verizon DNS response in frame 36 is highlighted and expanded in the following screen. Note that the “Answer” contains Target “pc-n0001-elba.avayalincroft.globalipcom.com” and port 5071.

Frame 37 is expanded below to illustrate the IP Office DNS A-query to determine the IP Address associated with the name “pc-n0001-elba.avayalincroft.globalipcom.com” (i.e., the “Target” returned by Verizon as shown in the prior screen).
Frame 38 is expanded below to illustrate the Verizon “answer” to the IP Office DNS A-query. Note that the IP address returned is 172.30.209.21. IP Office has now determined the IP Address (172.30.209.21) and SIP signaling port (5071) used by Verizon IP Trunk service on the production circuit, without any static provisioning of this information within IP Office.

In the following screen from a different trace left running for more than six hours and filtered to show only dns, frame 155 is highlighted and expanded below to show that the “Time to live” parameter returned by Verizon in the DNS SRV answer is 6 hours. Note that frame 21977, where IP Office sends another DNS SRV query, occurs roughly six hours after frame 155. That is, rounding the times shown in the trace below to seconds, time 21734 minus time 126 equals 21608 seconds. 21608 divided by 3600 seconds per hour = 6.00 hours.
9. Conclusion

IP Office is a highly modular IP telephone system designed to meet the needs of home offices, standalone businesses, and networked branch and head offices for small and medium enterprises. These Application Notes demonstrated how IP Office Release 7.0 can be successfully combined with a Verizon Business IP Trunk SIP trunk service connection to create an end-to-end SIP Telephony business solution. By following the example configurations provided in this document, customers using Avaya IP Office can connect to the PSTN via a Verizon Business IP Trunk SIP Trunk service connection, thus eliminating the costs of analog or digital trunk connections previously required to access the PSTN. Utilizing this solution, IP Office customers can leverage the operational efficiencies and cost savings associated with SIP trunking while gaining the advanced technical features provided through the marriage of best of breed technologies from Avaya and Verizon.

IP Office Release 7.0 has not been independently certified by Verizon labs. These Application Notes can be used to facilitate customer engagements via the Verizon field trial process, pending Verizon labs independent certification.

10. Additional References

This section references documentation relevant to these Application Notes. In general, Avaya product documentation is available at http://support.avaya.com

http://support.avaya.com/css/P8/documents/100129376

http://support.avaya.com/css/P8/documents/100129398

[IPO-SYSSTAT] IP Office Release 6.0 System Status Application, Issue 05a, February 12, 2010
Document Number 15-601758
http://support.avaya.com/css/P8/documents/100073300

http://support.avaya.com/css/P8/documents/100129332

[IPO-MON] IP Office System Monitor, Document Number 15-601019
http://support.avaya.com/css/P8/documents/100073350

[IPO-11001200] IP Office Release 7.0 1100/1200 Series Phone Installation, March 2011

Additional IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/
The Application Notes referenced below correspond to the formal compliance testing by Avaya and Verizon Business for IP Office Release 6.0.

https://support.avaya.com/css/P8/documents/100082703

The following Application Notes provide the configuration that will enable IP Office Release 6.1 to perform like IP Office Release 6.0. That is, in reference [JRR-IPOR61], the newly configurable SIP features of IP Office Release 6.1, such as SIP REFER and DNS SRV, are disabled. The Application Notes referenced below were written to support Verizon certification of IP Office Release 6.1 based on formal compliance testing of IP Office Release 6.0.


10.1. Verizon Business

Information in the following Verizon documents was also used for these Application Notes. Contact a Verizon Business Account Representative for additional information.

- [VZ-Spec] Retail VoIP Network Interface Specification (for non-registering devices), Date of Issue 12-10-2010

11. Appendix – Example SIP Trunk Template

IP Office Release 7.0 introduces the capability to generate and use templates to facilitate system configuration. This section shows an example SIP Trunk Template generated from the configuration presented in this document.

```xml
<?xml version="1.0" encoding="utf-8"?>
<Template xmlns="urn:SIPTrunk-schema">
  <TemplateType>SIPTrunk</TemplateType>
  <Version>20110325</Version>
  <SystemLocale>enu</SystemLocale>
  <DescriptiveName>Verizon-IP-Trunk-with-Fax-G711</DescriptiveName>
  <ITSPDomainName>adevc.avaya.globalipcom.com</ITSPDomainName>
  <SendCallerID>CallerIDDDIV</SendCallerID>
  <ReferSupport>true</ReferSupport>
  <ReferSupportIncoming>1</ReferSupportIncoming>
</Template>
```
<ReferSupportOutgoing>true</ReferSupportOutgoing>
<RegistrationRequired>false</RegistrationRequired>
<UseTelURI>true</UseTelURI>
<CheckOOS>true</CheckOOS>
<CallRoutingMethod>1</CallRoutingMethod>
<OriginatorNumber />
<AssociationMethod>SourceIP</AssociationMethod>
<ITSPProxy>pcelban0001.avayalincroft.globalipcom.com</ITSPProxy>
<LayerFourProtocol>SipUDP</LayerFourProtocol>
<SendPort>5060</SendPort>
<ListenPort>5060</ListenPort>
<DNSServerOne>172.30.209.4</DNSServerOne>
<DNSServerTwo>0.0.0.0</DNSServerTwo>
<CallsRouteViaRegistrar>true</CallsRouteViaRegistrar>
<CallsRouteViaRegistrar />
<CompressionMode>G729A8K</CompressionMode>
<CallInitiationTimeout>6</CallInitiationTimeout>
<DTMFSupport>DTMF_SUPPORT_RFC2833</DTMFSupport>
<VoipSilenceSupression>false</VoipSilenceSupression>
<ReinviteSupported>true</ReinviteSupported>
<FaxTransportSupport>FOIP_G711</FaxTransportSupport>
<UseOffererPrefferedCodec>false</UseOffererPrefferedCodec>
<CodecLockdown>false</CodecLockdown>
<T38FaxVersion>3</T38FaxVersion>
<Transport>UDPTL</Transport>
<LowSpeed>0</LowSpeed>
<HighSpeed>0</HighSpeed>
<TCFMethod>Trans_TCF</TCFMethod>
<MaxBitRate>FaxRate_14400</MaxBitRate>
<EflagStartTimer>2600</EflagStartTimer>
<EflagStopTimer>2300</EflagStopTimer>
<UseDefaultValues>true</UseDefaultValues>
<ScanLineFixup>true</ScanLineFixup>
<TFOPEnhancement>true</TFOPEnhancement>
<DisableT30ECM>false</DisableT30ECM>
<DisableEflagsForFirstDIS>false</DisableEflagsForFirstDIS>
<DisableT30MRCompression>false</DisableT30MRCompression>
<NSFOvrride>false</NSFOvrride>
</Template>